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Requirements for Making Accessible Excel 2010 Documents 

at the U.S. Department of Education 
 

Assistive technology is used by individuals to help them understand electronic information.  For 

example, screen readers or text-to-speech software is one tool available and assists individuals 

who are blind, have low vision, or a learning disability.  This special technology interprets words 

on the page and translates them to a computerized voice that reads the information.  You may 

have heard the name JAWS or Window-Eyes as these are some examples of this assistive 

technology. Accessible documents work in partnership with assistive technology to ensure 

individuals with disabilities have access to information.  

Listed below are basic Excel 2010 Requirements that help make documents accessible and 

come from Section 508 of the Rehabilitation Act.  The Department has identified thirteen 

requirements that are divided into four major categories:  

 Document Layout and Formatting,  

 Document Images,  

 Document Tables, and  

 Other. 

 

These thirteen requirements are further organized into “Do” and “Do Not” categories to help 

with clarity.  The majority of these requirements provide an underlying technical structure so 

that they can be used effectively by assistive technology.  When you create an accessible 

document, you are using methods that make a document usable by individuals with any type of 

disability.  A little change on your part to use built-in features makes a big difference for 

individuals with disabilities. 

Excel 2010 has a built in accessibility checker.  However, the rules in the accessibility checker do 

not match the requirements at the Department.  Therefore, the checker can be helpful in 

identifying some issues (i.e., missing alternative text, etc.), but a document will not be 

considered accessible until it adheres to all the requirements listed below.
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Document Layout and Formatting 

DO: 

1. Do use built-in features of Excel 2010 to encode a structure and layout 

that can be used by assistive technology.  

Documents should be created using built-in features to create the underlying technical 

structure that allows assistive technology to work properly.  Without such structural 

formatting, individuals using assistive technology will not be able to navigate through 

documents quickly and efficiently.  The next three sub-points identify common built-in 

features that assist with structure. 

1.1. Tables 

When creating documents with tables to create a tabular structure, use the 

built-in table command under the Insert tab Tables section.  Do not use tabs or 

spaces to display columns and rows of information. 
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1.2. Columns 

Do not use tabs, spaces, or text boxes to create columns.  Instead, insert a table 

into an excel document when you need information in columns.  Using tables will 

ensure that assistive technology can correctly interpret text flow (or logical 

reading order). 

1.3. Headers and Footers 

Assistive Technology cannot easily read information imbedded into Excel 2010 

headers and footers; therefore, it is important to only put redundant 

information in these locations.  For example, if the Title of the Worksheet is 

listed on the First page and the author wants to put it in the footer so that it 

shows on every page that is fine because it’s redundant information.  However, if 

the author wants to put the Department web address and address in the footer 

and it’s not listed anywhere else in the Worksheet, this is not acceptable as it 

does not create a comparable document. 

2. Do ensure all links work (are linked to active Web destinations). 

DO NOT: 

3. Do not rely on color-coding as the only means of conveying 

information or distinguishing a visual element.   

Color is useful in conveying important information.  However, when color alone is used to 

convey meaning (i.e., making a section of text red), then a person who is blind or colorblind 

will not have access to the information.  Therefore, color alone will not make information 

accessible.  A remedy would be to use color and another indicator.   
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4. Do not use blinking text, objects, or other elements having a flash or 

blinking frequency between 2 Hz and 55 Hz. 

Blinking text, objects, or other elements that have a flash or blinking frequency in this range 

may cause seizures in individuals with photosensitive epilepsy and may be distracting to 

individuals with learning disabilities.  Therefore, these frequencies should not be used. 

Document Images 

DO: 

5. Do provide a text equivalent for every non-text element. 

Documents are usually a combination of text and non-text elements (i.e., images, photos, 

charts, graphical text or audio files).  Because a screen reader cannot read a non-text 

element, it is important to include text equivalents so that people using assistive technology 

have access to the graphical elements. Text equivalents are referred to as “alt text” or 

alternative text that describes the information in a non-text element.  
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Right-click on the non-text element and select “Format Picture.”  Click on the “Alt Text” tab 

and type in text that describes the non-text element and select “Close”. 

6. Do group multiple associated images as one object (i.e., 

Organizational Charts) and use one alternative text (alt tag) for the 

image. 

When creating a document image with multiple associated images, instead of providing an 

alternative text for each individual component, you must group the images together and 

then provide one alternate text for the whole image.   
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7. Do ensure that complex images, diagrams or charts have descriptive 

text immediately after the image or in an appendix. 

When creating a complex image, diagrams or charts, it may not be possible to create an 

alternative text that sufficiently describes the object.  Therefore, it is necessary to provide 

descriptive text immediately after the image or in an appendix.  See the example below.   
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Example Figure 2: 

 

 

The table below shows the data for Governmental Activities Net Assets for Fiscal Years 2005 

to 2008 with amounts in millions of dollars: 

GOVERNMENTAL ACTIVITIES 2005 2006 2007 2008 

Invested in Capital Assets, Net of Related Debt 53,815 55,473 56,438 58,208 

Restricted 24,110 25,993 29,347 31,358 

Unrestricted 3,753 8,696 12,565 11,105 

Total Governmental Activities Net Assets 81,678 90,162 98,350 100,671 
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Document Tables 

DO: 

8. Do ensure that tables containing ‘data’ have the first row designated 

as a ‘Header Row’.  

You identify the header row when you create a new table by selecting the range of cells 

where you want the table to appear.  From the Insert tab, click on “Table” and in the Create 

Table dialog box, select “my table has headers”.  Click “OK”.  

 

You may also designate a header row after creating a table.  Select your header row and 

then select the Design tab.  Within the “Table Style Options” group, select “Header Row”.  
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9. Do describe and label tables when appropriate. 

There are various ways to describe and label a table.  In this example, the cells immediately 

preceding the table were used for a label.  A description of the table in this location would 

also be appropriate. 

 

10. Do repeat the header row at the top of each page when a table 

spans multiple pages.  

When inserting a table into an Excel document, it is important that the header row repeat 

at the top of the page when the table spans multiple pages.  You can ensure this happens by 

selecting the Page Layout tab, opening the Page Setup dialog box, selecting the Sheet tab, 

and selecting the range of cells to repeat under Print titles.  Then press “OK.” 
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DO NOT: 

11. Do not create tables with merged or split cells or with multilevel 

headings in the data cells.  Do use mark-up to keep row and headers 

associated with the right data cells in simple data tables. 

A data table is a grid that contains a set of related information laid out in rows and columns 

with headers at the beginning of the columns and/or rows.  Visually, data tables are easy to 

understand because a sighted user can scan up to the top of the column or the beginning of 

the row to read the column and row headers for any data cell in the table.  Individuals using 

a screen reader rely on the software to announce the column or row headers.  Therefore, it 

is important to identify the headings in a table so that a screen reader will be able to clearly 

match which heading relates to a data cell.  However, because of the constraints of current 

technology, only simple tables can be made accessible in Excel.  More complex tables might 

be made accessible by conversion and remediation to PDF.  

Figure 1: An example of an inaccessible table in Excel (not simple) 

 

Figure 2: An example of an accessible table in Excel (simple) 
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12. Do not create tables with empty rows or columns. 

Do not create tables with empty rows or columns for formatting purposes.  Screen readers 

read every cell; therefore, if there are empty cells for formatting purposes “blank cell, blank 

cell, blank cell” will repeat and this is very distracting when trying to understand an excel 

spreadsheet.  In Figure 3 below, there are many blank rows prior to the start of the diagram 

and since a screen reader starts at A1, not starting content or instructions at this cell makes 

it very difficult for a person using a screen reader to find the content.  In addition, Columns 

B, D, F, H and J and Row 9 would all repeat “blank cell” over and over.  Figure 4 is the same 

information presented in an accessible design.  The content begins in A1, the information is 

still separated using borders but there are no empty rows or columns. 

Figure 3: Example of Table with Blank Columns and Rows (inaccessible). 

 

Figure 4: Example of Table without Blank Columns and Rows (accessible) 
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Other 

DO:  

13. Do provide an alternative format, with equivalent information and 

functionality, if a document cannot be made accessible.  This option 

should be used as a last resort. 

Following these basic requirements will increase the accessibility of your documents, but it 

does not guarantee accessibility to any specific disability groups.  In cases where more 

certainty is required, it is recommended that you test the office documents with end users 

with disabilities, including screen reader users, or send to the Assistive Technology Team for 

testing 

While basic requirements have been provided, more complex projects may have additional 

standards applied such as the technical standards in Section 508 in 1194.21, 1194.22, and 

1194.31.  If you are creating forms in an Excel Document please contact the Assistive 

Technology Team for additional information at OCIOATTeamGov@ed.gov or contact via 

phone at: 202.453.7320.  

This document sets out basic requirements on making Excel 2007 documents accessible.  
We will continue to work on improving this document to make it even more user-friendly 
and ensure that it provides the most thorough and up-to-date information possible.  Any 
feedback that you have on possible improvements would be appreciated and can be sent to 
Holly.Anderson@ed.gov. 
 
This document has been a team effort.  A huge thank you to everyone on the development 
team: Don Barrett, OCIO; Crystal Jones, OCIO; Terri Youngblood, OCIO; Christopher Coro, 
OVAE; Geoff Rhodes, OSERS; and Jim Richards, Training and Development. 
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